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Follow the precautions listed below to avoid permanent damage to the emulator.
I.  Always use a grounding strap to prevent damage resulting from electrostatic discharge (ESD).
II. Power-Up Precautions.

1. Ensure that all power to the emulator and the target application (if any) is turned OFF.

2. Connect the target pod to the target application (if any).
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Electrical Safeguards

Follow the precautions listed below to avoid permanent damage to the emulator.

I.  Always use a grounding strap to prevent damage resulting from electrostatic discharge (ESD).

II. Power-Up Precautions.

3.
4.
5.
6.

Ensure that all power to the emulator and the target application (if any) is turned OFF.
Connect the target pod to the target application (if any).
Power up the emulator, then press the RESET button.

Power up the target application (if any).

III Power-Down Precautions.

When powering down, follow this procedure in the precise order shown below:

1.
2.
3.

Power down the target application board (if any).
Remove the target pod.

Power down the emulator.

NOTES:

1.

Refer to the “Precaution List” section of the Product Information sheet for additional operating
precautions specific to various devices.

Do not leave the emulator powered up with the RS-232C cable connected to a powered-down PC.

Before inserting target pod into target application board, refer to Chapter 2 to determine appropriate
jumper selections and options.

UMO005100-IRR0400 iii
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ZilLOG

ABOUT THIS MANUAL

We recommend that you read and understand everything in this manual before setting up and
using the product. However, we recognize that users have different styles of learning. There-

fore, we have designed this manual to be used either as a how-to procedural manual or a ref-
erence guide to important data.

The following conventions have been adopted to provide clarity and ease of use:

Universe Medium 10-point all-caps is used to highlight to the following items:
— commands , displayed messages

— menu selections, pop-up lists, button, fields, or dialog boxes

— modes

— pins and ports

— program or application name

— instructions, registers, signals and subroutines

— an action performed by the software

— icons

Courier Regular 10-point is used to highlight the following items
— bit

— software code

— file names and paths

— hexadecimal value

Grouping of Actions Within A Procedure Step

Actions in a procedure step are all performed on the same window or dialog box.
Actions performed on different windows or dialog boxes appear in separate steps.
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/ / CHAPTER 1
= J INTRODUCTION

ZiLOG
OVERVIEW

Congratulations for selecting a fine development tool! The Z86L9900100ZEM ICEBOX is
ZiLOG'’s in-circuit emulator providing emulation for the Z8 family of IR controllers. The
emulator is also capable of OTP programming for the family being emulated. The emulator
consists of an emulation daughter board that is plugged into a 64K motherboard via P1 and
P2 headers. The Z86D99 ICE chip is used as the emulation processor on the daughter board.

The motherboard provides host communication interface, control processor, 1/0 space
decoding and LED indicators. The emulator is designed to be used with ZiLOG Developers
Studio, giving the user a total package to write, edit and debug their applications.

UMO005100-IRR0400 1-1
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Emulator Features Introduction

EMULATOR FEATURES

Key features of the Z86L.9900100ZEM ICEBOX include:
e Supports up to 32K of ROM
* Vary the operating voltage from 3.0-4.0V
* Supports in-circuit emulation on target systems that operate from 3.0-4.0V
* The user can choose to power the ICE chip from either the emulator or target board
* Supports IR devices that operate up to 8MHz
e Emulates 28 and 40-pin DIP and 28-pin SOIC
* OTP programming for 28 pin DIP and 28 pin SOIC, 40 pin DIP packages

e Emulates and supports all the features and functions for a specified Z8 IR
microcontroller

* Multitasking allows the user to use other Windows applications while ZiLOG
Developer Studio (ZDS) is running

EMULATOR LIMITATIONS

The Z86D99 ICE chip’'s ROM/ROMLESS pin is used to configure the ICE CHIP for 32K of
internal ROM. This configuration affects the Z86L9900100ZEM ICEBOX in the following
ways:

¢ Will not support emulation of a ROMLESS operation mode

* [fthe host software specifies that a device has between 4K to 32K of ROM the emulator
operates as if it is emulating a device with 32K of ROM

To emulate pull-up transistors for their target board, you must manually set the emulator’s
pull-up resistor dip switches. See page 2-12 for the proper settings of the emulator’s dip
switches.

Note: Mask option pull-up resistance at 3V is about 200k Ohm +/-50% at room temperature. Lower
voltage may cause an increase in resistance.

UMO005100-IRR0400



Introduction

Supported ZiLOG Devices

SUPPORTED ZILOG DEVICES
Table 1-1 shows the products supported by the Z86L9900100ZEM ICEBOX:

TABLE 1-1. SUPPORTED PRODUCTS

Packages Emulation OTP Required accessories
28 PDIP | Z86L991PZ008SC |Z86D991 28 PDIP emulation pod
PZ008SC |28 PDIP program platform
(PC ASSY#99C0667-001)
28 SOIC | Z86L991SZ008SC |Z86D991 28 PDIP emulation pod and aDIP to SOIC
SZ008SC | conversion adapter from Emulation
Technology (AS-DIP 6-028-S003-1 or AS-DIP-6-
028-S003-2)
28 SOIC program platform
(PC ASSY#99C0668-001)
40 PDIP | Z86L990PZ008SC |Z86D990 |40 PDIP emulation pod
PZ008SC |40 PDIP program platform
(PC ASSY#990716-001) Rev. B
48 SSOP |N/A Z86D990 | Accessories for the 48 pin SSOP will be
HZ008SC |available the 4th quarter of 2000

HARDWARE SPECIFICATIONS

OPERATING CONDITIONS

Operating Humidity:

Operating Temperature:

Clocks:

Serial Baud Rate:

PoOowER REQUIREMENTS

10%-90% RH (Non condensing)
20 £10°C

The control processor operates at 7.3728 Mhz, the

emulation processor operates at 8Mhz
57,600 bps

This emulator requires an external 5VDC power supply.
+4.75VDC to +5.25 VDC Max (+5.0 VDC typical)

Operating Voltage (Input):

Operating Voltage (Target):

Operating Current:

+3.0 VDC to +4.0 VDC Max
0.8A typical 1.5A MAX
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ZILG0 G GUI-Supported Compiler, Assembler Formats Introduction

SERIAL INTERFACE

ZiLOG Developer Studio communicates with theZ86L9900100ZEM ICEBOX using a
DB25, RS-232 and DCE cable (TxD, RxD only).

GUI-SUPPORTED COMPILER, ASSEMBLER FORMATS

The Emulator supports object (binary or Intel hex) code files produced by ZiLOG Developer
Studio (ZDS), ZiLOG Macro Cross Assembler (ZMASM).

KIT CONTENTS

The emulator kit contains one each of the following items:
Z86L9900100ZEM ICEBOX
Z86D991 40 PDIP program platform ZiLOG PC: 99C0716-001
e 786D991 28 PDIP program platform ZiLOG PC: 99C0667-001
e 786D991 28 SOIC program platform ZiLOG PC: 99C0668-001
* 40 PDIP emulation pod with cable ZiLOG PC: 99C0206-001
e 28 PDIP emulation pod with cable ZILOG PC: 99C0217-001
* 5V Power Cable with banana plugs
e RS-232 Serial Cable, 9-pin M-F
* ZIiLOG Developer Studio Installation CD
e Z86L99 ICEBOXUser's Manual

ADDITIONAL ITEMS NOT SUPPLIED
The following items are required but are not currently supplied in the emulator kit:

* A source of power (+5VDC typical) for the emulator. This can be a laboratory power
supply with current rating of at least 1.5 ampere.
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Introduction Computer Requirements

OPTIONAL RECOMMENDED ITEM
The following items are recommended:

* Your target design. Typically this is a wire-wrapped or printed circuit prototype that
includes a socket for the target device which the emulator cable/pod plugs into.

e Z8 C-Compiler
* QOscilloscope

* Logic Analyzer
COMPUTER REQUIREMENTS

MINIMUM REQUIREMENTS
IBM PC (or 100-percent compatible) Pentium-Based Machine
75 MHz
16 MB RAM
VGA Video Adapter
Hard Disk Drive (12 MB free space)

CD-ROM Drive (a CD-ROM drive is not needed if you download ZDS from the web at
www.zilog.com)

RS-232 COM Port

Mouse or Pointing Device

Microsoft Windows 95/98/NT

The following enhancements to the minimum requirements are recommended:
166MHz IBM PC

SVGA video adapter

UMO005100-IRR0400 1-5
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Contacting ZiLOG Customer support Introduction

CONTACTING ZILOG CUSTOMER SUPPORT

ZILOG has a worldwide customer support center located in Austin, Texas. The customer
support center is open from 7 a.m. to 7 p.m. Central Time.

The customer support toll-free number for the United States and Canada is 1-877-ZiLOGCS
(1-877-945-6427). For calls outside of the United States and Canada dial 512-306-4169. The
FAX number to the customer support center is 512-306-4072. Customers can also access
customer support via the website at:

* For customer servicehitp://register.zilog.com/login.asp?login=servicelogin
* For technical supportitp://register.zilog.com/login.asp?login=supportlogin

For valuable information about hardware and software development tools go to ZiLOG home
page at http://www.zilog.com. The latest released version of the ZDS can be downloaded
from this site.
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/ / CHAPTER 2
= J SET-UP AND INSTALLATION

ZiLOG
HARDWARE INSTALLATION

Before installing the hardware, refer to Figure 2-1 for a diagram on connecting the emulator
to a PC and power supply; Figure 2-3 provides option jumper locations.

QUICK INSTALLATION INSTRUCTIONS
To install the hardware utilizing a 5VDC wall-adaptor power supply, perform the following.

1. Set the correct jumper setting for powering the ICE chip and target board. See Emulator
connection on page 2-2.

2. Plug a 5.0 VDC 1.5 Amp Wall Power Adaptor to the power connector on the
Z86L9900100ZEM ICEBOX.

. Turn on the power supply and ensure that it is set to + 5.0V and current limited at 2.5A.
. Connect the serial cable to the PC.

. Connect the emulator to the target board (if performing in-circuit emulation).

. Set up the oscillator and option jumpers.

. Power up the Z86L.9900100ZEM.

N o o~ W
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2I1LO @ Hardware Installation Set-Up and Installation

COMPLETE INSTALLATION INSTRUCTIONS

The following procedures illustrate a complete step-by-step guide on installing the emulator.

Emulation Cable Power Supply

Serial Cable

COM1-4

100-Percent Compatible PC

FIGURE 2-1. EMULATOR CONNECTION

Set Power Jumper

The Z86L9900100ZEM ICEBOX allows the user to power the emulator and target from a
variety of different sources. Before powering the emulator the user should select their power
configuration.

CAUTION!

The user must choose their power source before powering the emulator. Before selecting a
power source study Figure 2-2, which shows a schematic of the J6 power jumper. Failure to
properly configure the power source will result in damage to the emulator or target.
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Set-Up and Installation Hardware Installation T

The user should choose from one of the below options when selecting their power source

e Jumper pin 1 to pin 3 and pin 2 to pin 4 to power both the ICE chip and target from the
emulator’s adjustable voltage regulatefault settiny

¢ Jumper pin 1 to pin 3 to power the ICE chip with the emulator’s adjustable regulator
¢ Jumper pin 2 to pin 4 to power target with the emulator’s adjustable regulator

¢ Jumper pin 3 to pin 4 to power the ICE chip from the target

CAUTION!

When powering the target from the emulator ensure that the target’'s power supply is discon-
nected .

Emulator Adjustable
Voltage Regulator
1 2
® ®
3
ICE chip | Target
5 6
@ 9
7 8
Voltage Digital to Analog Converter

FIGURE 2-2. J6 JUMPER SCHEMATIC

UMO005100-IRR0400 2-3



Hardware Installation Set-Up and Installation

AT
RS-232C  — J6 = Power = Debug Reset
= ]2 = pins

- .
= = Logic analyzer|— Voltage
= = connector | — adjuster
J1 J2 =
OTP programing =
interface —
—J4 P3
- J3
|JP1
Ice Chip
Oscillator
JP2 0
Target Pod PG JI 11T TTTETEEIEEETEEETTTTI -_—J7
Target Pod PS5 |11 TEEEEIEEEEETETEEEE TR rrrrd LEDS

FIGURE 2-3. Z86L9900100ZEM ICEBOX EXTERNAL TOP VIEW
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Set-Up and Installation Hardware Installation T |. m G‘

Connect the Power Supply
1. If the power supply provides voltage adjustment:
* Turn the power supply on and adjust it to +5V
* Adjust the setting adjustment for at least 2.5A, if there is a current-limiting adjustment.

2. Turn the power supply off.

3. Locate the power cable (red wire, black wire, and banana plugs on the other end). Plug in
the black banana plug into the black jack on the power supply (labeled COM, GND, or with
the ground symbol). Plug the red plug into the red jack on the power supply (labeled +, +V
or +5V).

4. Plug the white connector on the other end of the cable into the matching 4-pin connector
on the back side of the emulator. (This connection is keyed to ensure against an improper
connection.)

NoTe: The ZiLOG Power Supply Accessory Kit (ZPS05V00ZAC), which is sold separately, provides

a fixed-5V Universal Output Power Supply, accepts 110V to 220V AC input, and includes a power

cable and an in-line jack cable.

CAUTION!
Always check the supply voltage before plugging in the power cord.

Connect the Serial Cable to the PC

Locate the serial cable. Connect the male end to the female connector on the back of the ICE-
BOX, and the female end to either the COM1, COM2, COM3, or COM4 connector of the
host PC.

Norte: If connector availability is limited to a 9-pin COM1 through COM4, then use either a different
cable or a 25-pin to 9-pin converter. (Available at any electronics store for a nominal fee.)

UMO005100-IRR0400 2-5
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Connect to the Design
Connect to the target design by performing the following steps:

1. Locate the emulation cable for the device.

CAUTION!

Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the cable into the target device. Ensure that the pin 1 marking (as indicated by the red
mark on the ribbon cable) matches pin 1 on the target board.

3. Plug the other end of the cables into target pod on top of the emulator. See Figure 2-3 for
the location of the target pod.

4. Select the power source for the Z86D99 ICE chip by configuring the J6 jumper. See
Table 2-2 for more information on jumper settings and Figure 2-3 for the location of the J6
jumper.

5. Select either the supplied 8MHz oscillator or the target’s oscillator to clock the ICE chip.
See Jumper settings on page 2-10 for more information on how to configure the emulator
to use the target boards oscillator.

CAUTION!

The user can not run the emulator’s oscillator if the target oscillator or XTAL is connected. At
this time use one of the following methods to set the ICE-chip’s clock:

* To use the emulators oscillator remove the target’s oscillator and connect pin 2 to
pin 3 on the J5 jumper

* To Use the target’s oscillator and connect pin 1 to pin 2 on the J5 jumper and remove
the ICEBOX’s 8 MHz oscillator located at Y1.

2-6 UMO005100-IRR0400



Set-Up and Installation Hardware Installation T |. m G‘

Adjust the voltage

If the emulator is powered by its adjustable regulator then the voltage must be manually set.
Set the emulator voltage by performing the following steps:

CAUTION!

If the target and emulator are using separate power supplies then the ICE chip voltage must be
adjusted to match the target’'s device voltage. Failure to match the target devices voltage with
the ICE chip’s voltage could result in damage to the emulator, target device or ICE chip.

1. Locate the voltage adjuster on top of the emulator. See Figure 2-3 for the location of the
voltage adjuster.

2. Attach the voltmeter lead to either pin 1 or pin 2 on the J6 jumper and ground.

3. Apply power to the emulator with the target device disconnected.

4. Turn the voltage adjuster’s screw until the voltmeter read-out matches the target device
output voltage.

Connect Logic Analyzer (Optional)

The logic analyzer can either be connected as part of the initial setup, or later as the user con-
tinues working with their design.

Connect to a logic analyzer by performing the following steps:

1. Locate the cable for the logic analyzer.

Note: Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the logic analyzer into the ZiLOG logic analyzer adapter (sold separately from the
Z86L9900100ZEM ICEBOX Kit).

Note: The logic analyzer adapter can be ordered from customer support by requesting part number

98C0289-001.

3. Plug the cable from the ZiLOG logic analyzer adapter into the emulator. Ensure that the pin
1 marking (as indicated by the red mark on the ribbon cable) matches the pin 1 on the target
board. See Figure 2-3 for the location of the logic analyzer connector.

UMO005100-IRR0400 2-7
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Software Installation Set-Up and Installation

Power the Emulator

If anything unusual (such as an unexpected sound and/or smell occurs when turning on the
power supply, turn off the power supply and check the setting for the J6 jumper. See Emula-
tor connection on page 2-2. If the power supply allows voltage adjustment, adjust it again to
+5V. (It may be somewhat lower than +5V because of the emulator load.

After power-up, press the RESET button to reset the ICE chip. (Pressing the RESET button
avoids bus contention on the 1/O lines.) If the emulator is not powering your design through
the V¢ pin, turn on the power supply of the design.

CAUTION!

If your design already has a power supply, do not power your design from the emglammnyV

When powering down, follow the procedure described below:
1. Power down the target application board (if using the target power supply).
2. Power down the emulator.

Note: Refer to the complete Electrical Safeguards information shown on the inside cover of this man-
ual.

SOFTWARE INSTALLATION

For more information on installing ZDS refer to the user manual PDF that is included on the
installation CD-ROM or download ZDS literature from the ZiLOG web page at zilog.com.

EMULATOR OPERATION

The following topics guide the user on how to operate the emulator and configure jumper set-
tings.

RESETTING

Press the RESET button on the emulator to reset the state of the target device and the status
that was established using ZDS.

For example, the emulator sets the program counter to %000C.

After reset, wait until the Ready LED is ON and has finished blinking before starting ZDS.
Refer to the LED Operation section of this chapter for more details.

NoTe: Always press the RESET button on the emulator before starting ZDS.

UMO005100-IRR0400



Set-Up and Installation Emulator Operation

LED OPERATION

ZiLOG emulators use LEDs to communicate the different hardware states. The following

table gives a description of the LEDs. The Z86L9900100ZEM LED’s are located on the right
front of the emulator.

FIGURE 2-4. FRONT LED ASSIGNMENTS

LED Indication Description
READY |On Communicating in Bisync Mode and waiting for command
Off Communicating in ASCIl Mode or executing Bisync command
RUN On Running user code
Off Not running user code
OoTP On The Emulator is performing OTP programing
Off The Emulator is not performing OTP programming
PWR On Emulator is powered up and Self Test is completed
Off Power is off
Blink Emulator is self-testing

UMO005100-IRR0400 2-9
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Emulator Operation

Set-Up and Installation

JUMPER SETTINGS

The following table lists jumper setting that the are easily configured by the user. See
Figure 2-3 for the jumper locations.

TABLE 2-1. JUMPER SETTINGS

Jumper Pin Position Description

J1 N/A | Out (Default) OTP programming adapter pins

J2 N/A | Out (Default) OTP programming adapter pins

J3 1-2 Out (Default) Reserved for data memory (do not use)

Ja 1-2 Out (Default) Reserved for external memory (do not use)

J6 1-3 In (Default) ICE chip is powered by the emulator’s adjustable
regulator

J6 2-4 In (Default) Target is powered by emulator’s adjustable
regulator

J6 5-7 In ICE chip is powered by a programmable regulator
(The programmable regulator is currently not
supported . Contact ZiLOG customer support to see if
the programmable regulator has been released .)

J6 4-6 In Target is not powered by emulator (See Emulator
connection on page 2-2 for more information)

J7 N/A | Open (Default) Do not Jumper, jumping these pins will short port
4 pin 3 VCC! These two pins are used as a
connector for the port 4 pin 3 IR LED.

J8 1-2 In (Default) Connects Ports 4 pin 3 to target

J8 1-2 Out Disconnects ports 4 pin 3 from target

JP1 1-2 In Disable Vbo

JP1 1-2 Out (Default) Enable Vbo

JP2 1-2 In (Default) AVDD to VDD core

JP2 1-2 Out Target board will supply power to AVDD (a 40 pin
part is being emulated)

JP3 1-2 In A 28 pin part is being emulated

JP3 1-2 Out (Default) VCC_I isolates from AVDD (use internal filter)

JP4 1-2 In (Default) Cap’s to AVDD

JP4 1-2 Out N/A
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Set-Up and Installation Emulator Operation

TABLE 2-1. JUMPER SETTINGS (CONTINUED)

Jumper Pin Position Description

J1 N/A | Out (Default) OTP programming adapter pins

JP5 1-2 In ICE chip uses target oscillator/clock (see Note at the
bottom of the table)

JP5 2-3 In * (Default) ICE chip uses emulator oscillator/clock (see Note at
the bottom of the table)

NoTe: The user can not run the emulator’s oscillator if the target oscillator or XTAL is connected. At
this time use one of the following methods to set the ICE-chip’s clock:

* To use the emulators oscillator remove the target’s oscillator and connect pin 2 to pin 3 on
the J5 jumper

* To use the target’s oscillator and connect pin 1 to pin 2 on the J5 jumper

Setting Jumpers for Targets

For all targets ensure that JP2 and JP4 are always connected. For 40 pin targets also connect
JP3.
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ZiLOG Emulator Operation Set-Up and Installation

DIP SETTINGS

DIP switch banks S1 and S3 are used to disable digital functions for ports 1 and 3. DIP
switch banks S2, S4, S5 and S6 are used to emulate port pin pull-up transistors for the Ice
Chip. See Figure 2-3 for the location of the DIP switches. The following tables list DIP set-
tings that are easily configured by the user.

TABLE 2-2. DIP SETTINGS TO DISABLE DIGITAL FUNCTIONS

DIP bank Switch Description

S1 1 Turn off to disable digital functions for Port 5 Pin 0
S1 2 Turn off to disable digital functions for Port 5 Pin 1
S1 3 Turn off to disable digital functions for Port 5 Pin 2
S1 4 Turn off to disable digital functions for Port 5 Pin 3
S1 5 Turn off to disable digital functions for Port 4 Pin 4
S1 6 Turn off to disable digital functions for Port 4 Pin 5
S1 7 Turn off to disable digital functions for Port 4 Pin 6
S1 8 Turn off to disable digital functions for Port 4 Pin 7

TABLE 2-3. DIP SETTINGS TO SET PULL-UP RESISTORS

DIP bank Switch Description

S2 1 Turn on to set a pull-up resistor for Port 2 Pin 0
S2 2 Turn on to set a pull-up resistor for Port 2 Pin 1
S2 3 Turn on to set a pull-up resistor for Port 2 Pin 2
S2 4 Turn on to set a pull-up resistor for Port 2 Pin 3
S2 5 Turn on to set a pull-up resistor for Port 2 Pin 4
S2 6 Turn on to set a pull-up resistor for Port 2 Pin 5
S2 7 Turn on to set a pull-up resistor for Port 2 Pin 6
S2 8 Turn on to set a pull-up resistor for Port 2 Pin 7
S4 1 Turn on to set a pull-up resistor for Port 5 Pin 0
S4 2 Turn on to set a pull-up resistor for Port 5 Pin 1
S4 3 Turn on to set a pull-up resistor for Port 5 Pin 2
S4 4 Turn on to set a pull-up resistor for Port 5 Pin 3
S4 5 Turn on to set a pull-up resistor for Port 5 Pin 4
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Set-Up and Installation Emulator Operation

TABLE 2-3. DIP SETTINGS TO SET PULL-UP RESISTORS (CONTINUED)

DIP bank Switch Description

S4 6 Turn on to set a pull-up resistor for Port 5 Pin 5
S4 7 Turn on to set a pull-up resistor for Port 5 Pin 6
S4 8 Turn on to set a pull-up resistor for Port 5 Pin 7
S5 1 Turn on to set a pull-up resistor for Port 6 Pin 0
Sb 2 Turn on to set a pull-up resistor for Port 6 Pin 1
Sh 3 Turn on to set a pull-up resistor for Port 6 Pin 2
S5 4 Turn on to set a pull-up resistor for Port 6 Pin 3
Sb 5 Turn on to set a pull-up resistor for Port 6 Pin 4
Sh 6 Turn on to set a pull-up resistor for Port 6 Pin 5
S5 7 Turn on to set a pull-up resistor for Port 6 Pin 6
Sb 8 Turn on to set a pull-up resistor for Port 6 Pin 7
S6 1 Turn on to set a pull-up resistor for Port 4 Pin 0
S6 2 Turn on to set a pull-up resistor for Port 4 Pin 1
S6 3 Turn on to set a pull-up resistor for Port 4 Pin 2
S6 4 Turn on to set a pull-up resistor for Port 4 Pin 3
S6 5 Turn on to set a pull-up resistor for Port 4 Pin 4
S6 6 Turn on to set a pull-up resistor for Port 4 Pin 5
S6 7 Turn on to set a pull-up resistor for Port 4 Pin 6
S6 8 Turn on to set a pull-up resistor for Port 4 Pin 7

NoTe: Mask option pull-up resistance at 3V is about 200k Ohm +/-50% at room temperature. Lower
voltage may cause an increase in resistance.
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PERFORMING OTP PROGRAMMING

The Z86L9900100ZEM ICEBOX is designed for OTP programming. To perform OTP pro-
gramming perform the following steps:

1. Locate the supplied OTP adapter for the micro controller you wish to program. Consult
Table 1-1for the proper OTP adapter.

2. Insert the OTP adapter into the emulator's OTP Programming socket (J1 and J2), see
Figure 2-3.

3. Place the micro controller into the OTP programing adapter.

4. If the adapter is equipped with a ziff socket, ensure that the ZIF socket locking lever is in
the down (closed) position.

5. Perform OTP programing. Consult the ZDS user manual for more information on OTP
programing.

6. Pull straight up on the micro controller to remove it from the OTP programing adapter.

NoTEe: Be careful not to bend the micro controller’'s pins when removing it from the OTP adapter.
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/ / CHAPTER 3
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ZilLOG
EMULATION
The Z86L9900100ZEM ICEBOX uses the Z86D99 ICE chip to provide emulation for the Z8
family of IR controllers. The emulator is capable of OTP programming for the family being

emulated. The user can manually set pull-up resistors and adjust the voltage of the ICE chip
to match the target’s voltage.
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Overview

USING ZDS

This emulator is fully compatible with ZiLOG Developer Studio (ZDS) software. The fol-
lowing steps briefly describe the procedures necessary to setup and create projects with the
Z86L9900100ZEM emulator. A summary of the emulator’s available debug windows is also
included at the end of this chapter.

For more detailed information on using ZDS, refer to the ZDS User Manual (in PDF format)
located on the installation CD-ROM, or download the latest information from our web site at
www.zilog.com.

SELECT THE EMULATOR

To select the emulator and create a new project, perform the following steps:
1. Open ZDS by selectingtart>Programs>Zilog Developer Studio> ZDS.
2. ChooséNew Project from theFile menu. TheNew Project dialog box appears.

Norte: If the project has already been created, sdleoget from theProject menu and perform the
following steps for theZiLOG MCU Database dialog box. See Figure 3-1.

— Target Selection
Selection by
’7 " Farnily & Application Cancel |
b aster Chip Data |
IlH Remate j [ ! Settingsl
Praject Target: Ermulator:
IZBELSSDD‘I OOZE R "I
— Project Mame Praject type——
[CAWINNT Profiestwmostton’Desklopin . | & Application
 Library
‘ ¥ Include default startup files for C Compiler ‘  OTP Only

FIGURE 3-1. NEW PROJECT DIALOG BOX

3. SelectApplication in theSelection by field.
4. SelectR Remote from theMaster pop-up list.
5. Select a microcontroller from the IR Remote family inRheject Target pop-up list.
6. SelecZz86L9900100ZEM in the Emulator pop-up list.
3-2 UMO005100-IRR0400
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7. Click on the browse buttdn..) in theProject Name field. TheNew Project Browse
dialog box appears.

8. Enter the project file name and select a path ilN#he Project Browse dialog box.
Note: All build output files, such as linker and assembly files are saved in the same directory as the
project.
9. ClickSave. The project name appears in Br@ject Name field in the New Projatitlog
box.
10. Click onChip Data to view the micro controller specifications.
Note: Fields in the Chip Data page are read-only and can’t be modified.

11. Click OK. The new project is saved as the name specified in the New Project Browse
dialog box.

12. SelecEmulator Configuration from theProject menu. The Emulator Configuration
dialog box appears. See Figure 3-2.

Emulator Configuration E3

— Module

Cancel |

€1 Simulator

— Part

I Serial Com 1 j

—Baud Rate

| 57800 =l

FIGURE 3-2. EMULATOR CONFIGURATION DIALOG BOX

13. Ensure thaEmulator is selected in the Module field.

14. Select the port the emulator is connected to from the Port pop-up list.

15. Selec67600 from the Baud Rate pop-up list.

16. Click OK to close and apply the Emulator Configuration options.

17. SelecSave Project from theFile menu to save the emulator configuration setting.
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OPEN A PROJECT AND ADD FILES
A previously created project has the following attributes saved with it:
* Target settings
* Assembler and Linker settings for the specified target
¢ Source files (including header files)

Note: Use the Project Viewer window to view and access the various files in any given project.

Perform the following steps to open a previously created project:
1. SelecOpen Project from the File menu. The Open Project dialog box appears.

2. Inthe Open Project dialog box, seldw previously created project. The project appears
in the Project Viewer window. See Figure 3-3.

=l
(= g C:Program Files'ZIL0G D5 _2 004samples'Z8htutorial 2w
....... B 5 ource Files
i[O Dependancies
4| | —'I

| FileView |

FIGURE 3-3. PROJECT VIEWER WINDOW

Add an existing file
Perform the following steps to add an existing file to a project:

1. SelectAdd to Project>Files from theProject menu. The Insert Files into Project dialog
box appears. See Figure 3-4.
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Inzert Files into Project K E3
Look jn: I &y 78

Reaction. s

@ nee

File: name: |s-:anner Open I
Files of type: ISource Files(*.azm, * 2] j Cancel |

FIGURE 3-4. INSERT FILES INTO PROJECT DIALOG BOX

2. Select the file to add to the project.
3. Click Open. The file appears in the Project Viewer window. See Figure 3-5.

Zlx]

= EI C:\Program Files
|‘:"| £5 Source Filss

i - SCANRNEN 33M
[ &5 Dependencies

- zoannerh

N | File¥iew |

FIGURE 3-5. PROJECT VIEWER WINDOW WITH FILE

4. Double-click on the file in the Project Viewer window. The file appears in the ZDS main
Edit window.

NoTe: In some cases, non-editable files, sucto# files need to be included in a project.
These files will be displayed in the source file list, but cannot be opened. When the project is built,
these files are automatically linked.

5. SelectUpdate All Dependencies from theBuild menu. The Dependencies folder list
in the Project Viewer window is updated.
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Add a new file

1. SelectAdd to Project>New from the Project menu. The nsert New Files Into
Project dialog box appears.

2. Type a file name in the File Name field.

3. Click Open. The new file name appears in the Project Viewer window widsa
suffix, and a blank Edit window also appears.

Note: Header and Included files do not have to be added. The program detects those called by the
source code.
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AVAILABLE DEBUG WINDOWS

The following table lists the debug windows that are available using ZDS.

TABLE 3-1. DEBUG WINDOWS

Window Function (Updated values will display in red)

Watch '@ * Shows the symbols and the contents of the registers (see the
ZDS user manual for more information)

Z8 Standard * Shows the contents of the Z8 standard registers

Registers

Code Memory * Allows the user to monitor, edit, and download a file.ld or
file.hex into the Code Memory from generated assembly
source code

* Tracks a specific address entered in the Code Address edit box

Disassembly * Shows code memory along with the corresponding
disassembled code

* Allows the user to edit, and download a file.ld or file.hex into
the Code memory

* Follows the program counter

* Provides a complete scroll down with this window, however
the scroll up is limited

* Accesses the disassembly of code at the address specified in
the Code Address field

* The Disassembly window is automatically displayed when
debugging hex code or whenever there is no corresponding
source file available at the address specified by the program
counter

Z8 Register File * Shows all Z8 internal and external registers, all RAM pointer
and data registers, status registers and status flags, and stacks

* Monitor and edit write-able registers in this window

Z8 Expanded ¢ Displays the Z8 Expanded Register banks that are specified in
Register the configuration

¢ Monitor and edit write-able registers directly in this window by
selecting a specific bank tab

Working Registers * Modify and view working registers in this window

UMO005100-IRR0400 3-7
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TABLE 3-1. DEBUG WINDOWS (CONTINUED)

Window Function (Updated values will display in red)
Timer Counter * Modify the timer/counter registers in this window
Registers
Ports Register * Monitor and edit port registers in this window
Internal Data ¢ Display address from FF00 to FFFF
Memory

3-8
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X TROUBLESHOOTING GUIDE
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INTRODUCTION

Before contacting a ZiLOG representative or submitting a Problem Report, please follow
these simple steps. Also, check the Precautions and Limitations sections in the Product Infor-
mation document included with the emulator to eliminate other possible known problems. If
a hardware failure is suspected, contact a local ZiLOG representative for assistance.

If the initial ZILOG screen is not appearing after selecting the COM port and the screen mes-
sage displays Time-out while reading:

1. Check the RS-232C cable connection and communication port selection in ZDS. See Select
the Emulator on page 3-2 for more information on how to configure the host PC’s port.

2. Reset the emulator and ZDS.

3. If you are using the emulator’s oscillator, ensure that you removed the target’'s oscillator
and connected pin 2 to pin 3 on the J5 jumper.

4. If ICEBOX stops working after connecting to the target, check whether the target crystal is
removed while using the ICEBOX’s oscillator.

5. Try connecting another cable.

6. Check if transmit/receive signals need to be swapped.

Note: On some DB9 connectors for the COM ports, the transmit/receive signal may be swapped and
a Null Modem adapter may be required.

7. Ensure that the power supply is connected, is turned on, and power is available.

8. Ensure that the power supply is set at +4.75 VDC to +5.25 VDC Max (+5.0 VDC typical).

9. Ensure that the J6 power jumper has been properly configured. See Emulator connection
on page 2-2 for more information on setting the J6 jumper.

10. Check if power supply is supplying the required current (0.8A typical) to the emulator.
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11. Check P42 pin. If P42 stays low check the target pod and ensure that it is not shorting to
ground. If it is shorted, ensure that you are using the proper emulation pod, see Table 1-1.

12. After resetting the emulator, wait a minimum of 5 seconds before running ZDS.
13. If P42 always shows low, check the 40-pin target pod’s pin 31.

Note: The previous Z86L71 and Z86L98 ICEBOX 40 pin target pod have pin 31 connecting to
ground for emulating the L73/87/89. That target pod can not be used for Z86L990 emulation. Only use
the target cable which is shipped with the Z86L99 ICEBOX.

COUNTER JUMPS TO UNEXPECTED ADDRESS

Any instruction other than @l instruction is used to disable interrupts. Possible causes
include:

* The stack overflows into the general register locations.
e ExtraPOR PUSHIRET, orRETIs encountered (stack unbalanced).

* Program resets repeatedly.
— Program counter rolls over from value FFFF to 0000 and proceeds back to the
beginning of program.
— Watch-Dog Timer (WDT) is not initialized or refreshed.

* Unintialized interrupt vector is activated. The interrupt vector is not set to the interrupt
handler.

A-2 UMO005100-IRR0400
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ZDS ERROR MESSAGES

CAN NoT OPEN WINDOWS

If this message appears while attempting to open a window in ZDS, there may be too many
applications running. Try closing the other active applications or exit and restart your PC.

OUT OF SYNCHRONIZATION WITH THE EMULATOR

This message appears whenever communication between the emulator and the PC is inter-
rupted.

1. Ensure that the power cable is connected.
2. Ensure that the RS-232C cable is connected.

3. Change the baud rate setting (default9200 ). A lower setting usually improves
communications reliability.

4. Reestablish communication between ZDS and the emulator. See the ZDS user manual for
more information establishing communication with an emulator.
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Z i IL 0 G PROBLEM/SUGGESTION REPORT FORM

If you experience any problems while operating this product, or if you note any inaccuracies
while reading the User's Manual, please copy this form, fill it out, then mail or fax it to
ZiLOG. We also welcome your suggestions!

Customer Information

Name Country
Company Telephone
Address Fax Number
City/State/ZIP E-Mail Address

Product Information and Return Information

Serial # or Board Fab #/Rev. # ZiLOG, Inc.

Software Version System Test/Customer Support

Manual Number 910 E. Hamilton Ave., Suite 110, MS 4-3
Host Computer Description/Type Campbell, CA 95008

Fax Number: (408) 558-8536
Email: tools@zilog.com

Problem Description or Suggestion

Provide a complete description of the problem or your suggestion. If you are reporting a
specific problem, include all steps leading up to the occurrence of the problem. Attach
additional pages as necessary.
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Address Space

ANSI
ASCII
ASM
ASYNC
ATM

B

Baud
Binary
BISYNC

Bisynchronous
Communications

ZilLOG

Z861.99 ICEBOX USER’Ss MANUAL

GLOSSARY

Physical or logical area of the target system’s
Memory Map. The memory map could be physically
partitioned into ROM to store code, and RAM for data.
The memory can also be divided logically to form sepa-
rate areas for code and data storage.

American National Standards Institute.

American Standard Code of Information Interchange.
Assembler File.

Asynchronous Communication Protocol.
Asynchronous Transfer Mode.

Binary.

Unit of measure of transmission capacity.

Number system based on 2. A binary digit is a bit.
Bidirectional Synchronous Communication Protocol.

A protocol for communications data transfer used
extensive in mainframe computer networks. The

UMO005100-IRR0400
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ZilLOG
sending and receiving computers synchronize their
clocks before data transfer may begin.

Bit A digit of a binary system. It has only two possible
values: 0 or 1.

BPS Bits Per Second. Number of binary digits transmitted
every second during a data-transfer procedure.

Buffer Storage Area in Memory.

Bug A defect or unexpected characteristic or event.

Bus In Electronics, a parallel interconnection of the internal
units of a system that enables data transfer and
control Information.

Byte A collection of four sequential bits of memory. Two
sequential bytes (8 bits) comprise one word.

CALL This command invokes a subroutine

Checksum A field of one or more bytes appended to a block of n
words which contains a truncated binary sum formed
from the contents of that block. The sum is used to
verify the integrity of data in a ROM or on a tape.

COM Device name used to designate a communication

port.

Glossary-2
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Control Section

CPU

Cross-Linkage Editor

DSP

Emulator

External Symbol

GUI

H

Hex

Hexadecimal

ICE

IE

A continuous logical area containing code or user
data. Each control section has a name. The linker puts
all those control sections with the same name in one
entity. The linker provides address spaces to the
control sections. There are either absolute control
sections or relocatable ones.

Central Processing Unit.

A linkage editor that executes on a processor that is not
the same as the target processor.

Digital Signal Processing. A specialized micropro-
cessor that is tailored to perform high repetition math
processing and improve signal quality.

An emulation device. For example, an In-Circuit
Emulator (ICE) module duplicates the behavior of the
chip it emulates in the circuit being tested.

A symbol that is referenced in the current program file
but is defined in another program file.

Graphical User Interface. The windows and text that a
user sees on their computer screen when they are
using a program.

Hexadecimal, Half-Carry Flag.

Hexadecimal.

A Base-16 Number System. Hex values are often
substituted for harder to read binary numbers.

In-Circuit Emulator. A ZiLOG product which supports
the application design process.

Interrupt Enable.

UMO005100-IRR0400
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IM Immediate Data Addressing Mode.

IMASK Interrupt Mask Register.

IMR Interrupt Mask Register.

INC Increment.

INCW Increment Word.

Initialize To establish start-up parameters, typically involving
clearing all of some part of the device’s memory space.

Instruction Command.

INT Interrupt.

Internal Symbol

1/O

IPR

IRQ
ISDN

ISO

A symbol that is defined in a program file. This symbol
could be visible to multiple functions within the same
program file.

Input/Output. In computers, the part of the system that
deals with interfacing to external devices for input or
output, such as keyboards or printers.

Interrupt Priority Register.

Indirect Working-Register Pair Only.

Infrared. A light frequency range just below that of
visible light.

Interrupt Request.
Integrated Services Digital Network.

International Standards Organization.

Glossary-4
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JP Jump.

JR Jump Relative.

Library A File Created by a Librarian. This file contains a
collection of object modules that were created by an
assembler or directly by a C compiler.

Local Symbol Symbol visible only to a particular function within a
program file.

LSB Least Significant Bit.

MCU Microcontroller or Microcomputer Unit.

MI Minus.

MLD Multiply and Load.

MPYA Multiply and ADD.

MPYS Multiply and Subtract.

MSB Most Significant Bit.

Nibble A Group of 4 Bits.

NMI Non-Maskable Interrupt.

NOP No Operation.

Object Module

OMF

Programming code created by assembling a file with
an assembler or compiling a file with a compiler.
These are relocatable object modules and are input to
the linker in order to produce an executable file.

Object Module Format.

UMO005100-IRR0400
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OPC Operation Code.

Op Code Operation Code.

OoTP One-Time Programmable.

PCON Port configuration register.

PER Peripheral. A device which supports the import or
output of information.

POP Retrieve a Value from the Stack.

POR Power-On Reset.

Port The point at which a communications circuit termi-
nates at a Network, Serial, or Parallel Interface card.

PRE Prescaler.

PROM Programmable Read-Only Memory.

Protocol Formal set of communications procedures governing
the format and control between two communications
devices. A protocol determines the type of error
checking to be used, the data compression method, if
any, how the sending device will indicate that it has
finished sending a message, and how the receiving
device will indicate that it has received a message.

PRT Programmable Reload Timer or Print.

PTR Pointer.

PTT Post, Telephone, and Telegraph. Agency in many

countries that is responsible for providing telecommu-
nication approvals.

Glossary-6
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Public/Global Symbol

PUSH

r

R

RA

RAM

RC

RD

RES

Resolution

RFSH

ROM

ROMCS

RP

RR

SCF

A programming variable that is available to more than
one program file.

Store a Value In the Stack.

Working Register Address.

Register or Working-Register Address, Rising Edge.
Relative Address.

Random-Access Memory. A memory that can be
written to or read at random. The device is usually
volatile, which means the data is lost without power.
Resistance/Capacitance.

Read.

Reset.

In a digital image, the total number of pixels in the
horizontal and vertical directions.

Refresh.

Read-Only Memory. Nonvolatile memory that stores
permanent programs. ROM usually consists of
solid-state chips.

ROM Chip Select.

Register Pointer.

Read Register or Rotate Right.

Set C Flag.

UMO005100-IRR0400
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SIO Serial Input/Output.

SL Shift Left or Special Lot.

SLL Shift Left Logical.

SMR Stop Mode Recovery.

SN Serial Number.

SOIC Small Outline IC.

SP Stack Pointer.

SPH Stack Pointer High.

SPI Serial Peripheral Interface.

SPL Stack Pointer Low.

SRAM Static Random Access Memory.

SR Shift Right.

SRA Shift Right Arithmetic.

SRC Source.

SSI Small Scale Integration. Chip that contains 5 to 50
gates or transistors.

Static Characteristic of Random Access Memory that
enables It to operate without clocking signals.

ST Status.

STKPTR Stack Pointer.

Glossary-8
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SuB
SVGA
S/W
SWi

Symbol Definition

Symbol Reference

SYNC

TC

TCM
TCR
TMR

UART

UGE

UGT

Subtract.

Super Video Graphics Adapter.

Software.

Software Interrupt.

Symbol defined when the symbol name is associ-
ated with a certain amount of memory space,
depending on the type of the symbol and the size of
Its dimension.

Symbol referenced within a program flow, when-
ever It is accessed for a read, write, or execute
operation.

Synchronous Communication Protocol. An event or
device is synchronized with the CPU or other process
timing.

Time Constant.

Trellis Coded Modulation.

Timer Control Register.

Timer Mode Register.

Universal Asynchronous Receiver Transmitter.
Component or functional block that handles asynchro-
nous communications. Converts the data from the
parallel format in which it is stored, to the serial format
for transmission.

Unsigned Greater Than or Equal.

Unsigned Greater Than.

UMO005100-IRR0400
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ULE Unsigned Less Than or Equal.

ULT Unsigned Less Than.

UM User’s Manual.

USART Universal Synchronous/Asynchronous
Receiver/Transmitter. Can handle synchronous as well
as asynchronous transmissions.

USB Universal Serial Bus.

USC Universal Serial Controller.

uTB Use Test Box. A board or system to test a particular
chip in an end-use application.

Vv Volt, Overflow Flag.

Vee Supply Voltage.

Vpp Voltage from the Digital Power Supply.

Vpp Programmed Voltage.

VRAM Video Random-Access Memory. A special form of
RAM chip that has a separate serial-output port for
display refresh operations. This architecture speeds up
video adaptor performance.

VREF Analog Reference Voltage.

WDT Watch-Dog Timer. A timer that, when enabled under

normal operating conditions, must be reset within the
time period set within the application (WDTMR (1,0)). If
the timer is not reset, a Power-on Reset occurs. Some
earlier manuals refer to this timer as the WDTMR.

Glossary-10
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WDTOUT Watch-Dog Timer Output.

Word Amount of data a processor can hold in its registers
and process at one time. A DSP word is often 16 bits.
Given the same clock rate, a 16-bit controller
processes four bytes in the same time it takes an 8-bit
controller to process two.

WR Write.

WS Wafer Sort.

X Indexed Address, Undefined.

XOR Bitwise Exclusive OR.

XTAL Crystal.

V4 Zero, Zero Flag.

ZASM ZiLOG Assembler. ZiLOG’s program development

environment for DOS.

ZDS ZiLOG Developer Studio. ZiLOG’s program develop-
ment environment for Windows 95/98/NT.

ZEM ZiLOG Emulator.

ZiLOG Symbol Format Three fields per symbol including a string containing
the Symbol Name, a Symbol Attribute, and an Absolute
Value in Hexadecimal.

ZLD ZiLOG Linkage Editor. Cross linkage editor for ZiLOG’s
microcontrollers.

ZLIB ZiLOG Librarian. Librarian for creating library files from
locatable object modules for the ZiLOG family of
microcontrollers.

UMO005100-IRR0400 Glossary-11
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ZilLOG

ZMASM ZiLOG Macro Cross Assembler.

ZDS ZiLOG’s program development environment for
Windows 3.1 and up.

ZOMF ZiLOG’s Object Module Format. The object module

format used by the linkage editor.

Glossary-12
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